
Welc  me



Let’s get ready

• Earn DevOps points

• Goal of the sessions

• My DataMiner is up and running (50 DevOps points)

• AWS EC2 element is deployed from the cloud (50 DevOps points)

• IDP was able to discover and provision elements (50 DevOps points)

• Guidelines on questions/help in the session

some practical arrangements
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Let’s spin up your DataMiner System first

• Go to dataminer.services

• Log in or create a DCP account if 
you do not have one yet

• Become member of the Empower 
organization

• https://aka.dataminer.services/empo
werorganization

• Deploy a new DataMiner System

• Install DataMiner Cube

DEMO
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https://aka.dataminer.services/empowerorganization
https://aka.dataminer.services/empowerorganization


Let’s spin up your DataMiner System first

1. Go to dataminer.services

2. Log in or create a DCP account if you do not have one yet

3. Become member of the Empower organization: 
https://aka.dataminer.services/empowerorganization

4. Go back to dataminer.services and reload the page

5. Verify in the top right corner you are a member of the Empower organization

6. Click Deploy a new DataMiner System

7. Click Deploy a DataMiner System

8. Fill in a DataMiner System Name: use your first name and the initials of your last name(s).

9. Leave the DataMiner System URL the same as the Name.

10. Agree to the terms of service and click Deploy.

Exercise

exercise
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DataMiner as a Service (DaaS)

• Nothing brought with us to Mumbai, in the cloud

• Among the first in the world to use DaaS

• In pre-release

• Using Storage As A Service

• Connected to dataminer.services
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PREVIEW



How to connect to dataminer.services

• Full flow is documented 
(aka.dataminer.services/connect-to-the-cloud)

• One-time setup

• Steps

• Download Cloud Pack from DOJO

• Run the installer locally

• Cloud connect the system through Cube

Setting up the connection on an existing system
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https://aka.dataminer.services/connect-to-the-cloud


How to get cloud connected
Download Cloud Pack
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How to get cloud connected
Run installer

8



How to get cloud connected
Cloud connect the system through Cube
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How to get cloud connected
Open Cloud Admin through Cube
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Cloud connection security

• Azure B2C authentication

• Unified security between dataminer.services and 
DMS (account linking)

• Web Application Firewall

• Data Encryption

• At rest (AES-256 encryption)

• In transit (HTTPS/WSS)

• Secure managed services in Azure

• Secure development practices

11



Remote connect service

• Cube access from anywhere

• Remotely access all your web apps

12



Let’s provision our DataMiner System 

• Manual 
for static DataMiner Systems, managing a static ecosystem with static configuration

• With 3rd party tool (e.g. Ansible, Terraform, …) 
e.g. as part of the deployment of your core dataminer system

• IDP
for static DataMiner Systems, managing a dynamic / vast ecosystem

• DataMiner Catalog
for flexible deployment of DataMiner components and solutions that evolve continuously

How can this be done?
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demo

demo

exercise

exercise



manual

14

3rd party tool
e.g. Ansible - Terraform

3rd party 
inventory

?

Who is the 
reference 
source?

Components
Solutions

CI/CD

Auto 
Discovery

DataMiner Cube

IDP

Catalog

webservices



3rd party tool 

Ansible > webservices  

e.g. as part of the deployment of your core dataminer system
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tasks:
- debug:

msg: "Get Connection string"
- name: Connect With DataMiner

ansible.windows.win_uri:
url: "{{server}}{{connect}}"
return_content: yes
content_type: "{{jsoncontent}}"
url_method: POST
body: '{

"host": "{{server}}",
"login": "ansible",
"password": "DataMiner123@",
"clientAppName": "AnsibleApp",
"clientAppVersion": "1.0",
"clientComputerName": "AzureVM"
}'

register: connectionid
- name:

ansible.windows.win_uri:
url: "{{server2}}"
return_content: yes
content_type: "{{soapcontent}}"
url_method: POST
body: '<soap:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" 

<soap:Body>
<CreateElement xmlns="http://www.skyline.be/api/v1">

<connection>{{connectionid.json.d}}</connection>
<dmaID>1000000</dmaID>
<viewIDs>

<int>31</int>
</viewIDs>
<configuration>

<Name>ZiineAnsibleWindows_ClassRoom1</Name>
<ProtocolName>Microsoft Platform SNMP</ProtocolName>
<ProtocolVersion>1.1.0.28</ProtocolVersion>
<AlarmTemplate>ZiineMSTemplate</AlarmTemplate>



Let’s access your DataMiner System 

• Go back to dataminer.services

• Open the Admin page of your deployed system

• Hit the Open Cube button

• Credentials:

• User: DataMinerUser

• Password: DataMiner123!
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DEMO



Let’s access your DataMiner System 
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Exercise

1. Go back to the deployment progress page on dataminer.services

2. Click on Navigate to Admin.

3. Click the arrow next to your DataMiner system and click on Overview.

4. Click Open Cube to start a remote cube session.

5. Click Open DataMiner Cube.

6. In Cube Launcher, leave the host and alias as is and click Connect.

7. Login with:

• User: DataMinerUser

• Password: DataMiner123!

exercise



Leverage the DataMiner Catalog

• Any type of configuration (a single driver to a complete DataMiner solution)

• Perfect fit for components that evolve continuously

• Private & shared catalog

• Audit trailing

• EXERCISE: deploy package with AWS EC2 element instance

DataMiner Catalog
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Provision

components

deploy script

catalog

API
upload |  publish | deploy 

DEMO

exercise



Account Linking

• Prove DataMiner Identity

• Allows actions from the DCP

• Create and update shares

• Bot commands

• Remote Access auto login

• Catalog deployment

Unified security

DCP Account DataMiner Account

19



Account Linking

1. Go to dataminer.services

2. Under DataMiner Systems, next to your agent name, click Link account.

3. Click Continue to log on.

4. Log on with:

• User: DataMinerUser

• Password: DataMiner123!

5. Click Link accounts.

6. Close the tab page, return to dataminer.services and reload the page,

7. Verify the linking was successful by clicking the three dots
on the right of your DataMiner System’s name.

Exercise
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exercise



Leverage the DataMiner Catalog
Exercise
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Provision catalog

exercise

1. Create view ‘Infrastructure’ 

2. Go to catalog.dataminer.services

3. Search for AWS EC2 Demo.

4. Open the item and click Deploy.

5. Select your target DMS and click Deploy again.

6. Go back to dataminer.services and open the admin page for your system. 

7. Go to Deployments and verify the deployment was successful.

8. Go to Cube and verify the element AWS EC2 is present in the Infrastructure view.

9. Open the element and verify the Visio file is assigned.

10. Open the Protocols & Templates app and verify protocol Skyline Labs AWS EC2 is present, and 
the production version has been set.



IDP – Infrastructure Discovery & Provisioning

• Discover new inventory in an automated manner

• Direct element provisioning

• Provides centralized inventory management

• Based on open source CI-types

DataMiner Infrastructure Discovery Provisioning
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Provision
Rack 

Management

Firmware
Management

Document
Management

Resource 
Inventory

Resource 
Discovery

Config
Provisioning



IDP – Infrastructure Discovery & Provisioning

• Device discovery

• Provisioning

• Software management

• Configuration management

• Facility management

• Unique for a specific protocol or common for 
multiple element types

CI Type
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IDP Installation

• Run IDP setup install script

• Step exclusive to Empower. Normally we install 
IDP from Dojo

CI Types

24



IDP – Infrastructure Discovery & Provisioning
Exercise – Deploy CI Types
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exercise

1. Open the DataMiner IDP application.

2. Go to ADMIN > CI TYPES > Overview.

3. Verify there are no CI types present.

4. Go to catalog.dataminer.services

5. Search for Empower IDP - CI Types.

6. Open the item and click Deploy.

7. Select your target DMS and click Deploy again.

8. Go back to dataminer.services and open the admin page for your system. 

9. Go to Deployments and verify the deployment was successful.

10. In the DataMiner IDP application go back to ADMIN > CI TYPES > Overview.

11. Verify there are 3 CI types present.



IDP – Infrastructure Discovery & Provisioning
Exercise – Deploy CI Types
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exercise

1. Go to catalog.dataminer.services

2. Search for Linux Platform

3. Open the item and click Deploy.

4. Select your target DMS and click Deploy again.

5. Go back to dataminer.services and open the admin page for your system. 

6. Go to Deployments and verify the deployment was successful.

7. In the Protocols and templates application, verify the driver is present



IDP – Infrastructure Discovery & Provisioning
Exercise – Discover
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exercise

1. Open the DataMiner IDP application.

2. Go to INVENTORY > DISCOVERED.

3. Click on the DISCOVER… button.

4. Use the following IP RANGE 20.160.107.50 - 20.160.107.100 (backup: 20.82.5.0 – 20.82.5.50)

5. Click Next.

6. Discover Devices by CI Type.

7. All CI Types.

8. Disable Ping First.

9. Click Start Discovery.



IDP – Infrastructure Discovery & Provisioning

1. Go to IDP application > Admin > CI Types

2. Click Edit next to ZiineWebServer

3. Click Configure next to Provisioning

Exercise – Setup provisioning
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exercise



IDP – Infrastructure Discovery & Provisioning

1. Click Details next to Element details

2. Select Linux Platform protocol

3. Click Previous (x2)

4. Click Save

Exercise – Setup provisioning
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exercise



IDP – Infrastructure Discovery & Provisioning
Exercise – Provision
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exercise

1. Open the DataMiner IDP application.

2. Go to INVENTORY > DISCOVERED.

3. Multiselect both web servers

4. Click Provision

5. Verify that they show up under the Infrastructure view



IDP – Infrastructure Discovery & Provisioning
Exercise – Provision

31

exercise

1. Select Show response on the items with a matching CI type:

2. Verify they become available in the Infrastructure view.



IDP – Infrastructure Discovery & Provisioning
Exercise – Create your own CI type
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exercise

1. Go to catalog.dataminer.services and search for Cisco Manager.

2. Open the item and click on Version history.

3. Look for the latest 5.1.6.x entry which is 5.1.6.19 and click Deploy.

4. Select your target DMS and click Deploy v5.1.6.19.

5. Go to dataminer.services and open the admin page for your system.

6. Go to Deployments and verify the deployment was successful.

7. Go to IDP app > Inventory > Discovered

8. Select the row with the Unknown CI type and click Show Response.

9. Copy C3750 Software (C3750-IPSERVICES-M)



IDP – Infrastructure Discovery & Provisioning

1. In Protocols and Templates navigate to the Cisco Manager protocol

2. Right click on ALARM, Select New Alarm template

3. Enable alarming on operational status

1. Right click on TREND, Select New Trend template

2. Enable trending on ‘CPU Usage’

Exercise – Configure templates
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exercise



IDP – Infrastructure Discovery & Provisioning
Exercise – Create your own CI type (cont.)

34

exercise

1. In the DataMiner IDP application go to ADMIN > CI TYPES > Overview.

2. Click New.

3. Enter CI Type Name: ZiineCisco

4. Click Configure… next to Discovery.

5. Filter Discovery Protocol Types to SNMP.

6. In the list below click the plus sign next to the System Description ZiineDiscovery item.

7. Enter MATCH: Contains

8. Enter VALUE: C3750 Software (C3750-IPSERVICES-M)

9. Click Previous.

10. Click Configure… next to Provisioning.

11. Click Details… next to Element Details.

12. Enter Protocol: Cisco Manager

13. Enter Version: 5.1.6.19

14. Set Alarm and Trend templates to match previously created Cisco Manager templates

15. Enter Get Community: ZiinePublic_2023

16. Click Previous.



IDP – Infrastructure Discovery & Provisioning
Exercise – Create your own CI type (cont.)
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exercise

1. Click Views… next to Views.

2. Click the arrow next to Add element to an existing view.

3. Click the plus sign next to Infrastructure.

4. Verify below that Infrastructure is mentioned under SELECTED VIEWS.

5. Click Previous.

6. Click Previous.

7. Click Save.



IDP – Infrastructure Discovery & Provisioning
Exercise – Create your own CI type (cont.)

36

exercise

1. Go to INVENTORY > DISCOVERED.

2. Click on the DISCOVER… button.

3. Use the following IP RANGE 20.160.107.50 - 20.160.107.100 

4. Click Next.

5. Discover Devices by CI Type.

6. All CI Types.

7. Disable Ping First.

8. Click Start Discovery.

9. Select the Cisco device and click Provision.

10. Verify it becomes available in the Infrastructure view.



D A T A M I N E R  D E V O P S  E C O S Y S T E M

D A T A M I N E R  D E V O P S  E C O S Y S T E M

Set up your own
first CI/CD solution

for your

DataMiner System



DataMiner Integration Studio

• DIS version v2.40.1.23 requires at least Microsoft Visual Studio 2022.

Visual Studio Code and Visual Studio for Mac are not supported.

Installing Microsoft Visual Studio
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DataMiner Integration Studio

• DataMiner Integration Studio must be able to connect to addresses in the following ranges:

• https://login.microsoftonline.com/*

• https://aadcdn.msftauth.net/*

• https://*.dataminer.services/*

• https://*.skyline.be/*

Prerequisites

3



DataMiner Integration Studio

1. Check which version of Visual Studio you are using, download the correct 
DataMinerIntegrationStudio.vsix extension file, and place it in a temporary folder on your 
computer:

2. Double-click DataMinerIntegrationStudio.vsix.

3. If multiple versions of Microsoft Visual Studio have been installed on your computer, select the 
version on top of which you want to install the DataMinerIntegrationStudio.vsix extension.

4. Click Install.

Installing DataMiner Integration Studio
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Visual Studio version Download location

Visual Studio 2022 https://community.dataminer.services/download/dataminer-
integration-studio-insider-release-2/



DataMiner Integration Studio

5. When the installation is complete, click Close.

6. Start Microsoft Visual Studio. If it was running during the installation of the 
DataMinerIntegrationStudio.vsix file, restart it.

7. In the DIS menu, go to Settings > Account, and sign in with your dataminer.services account.

Installing DataMiner Integration Studio
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Agenda
W H A T ’ S  O N  T H E  M E N U

• DevOps

• Automation script development

• Git & GitHub

• GitHub Actions

75
DevOps
Points

75
DevOps
Points



DevOps
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8
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Automation script development

• Application Development Language C# for scripting?
• Performant, Robust, Coding Standards, IDE --> Collaboration!

• Visual Studio
• Integrated Development Environment (IDE)

• Visual Studio extension DataMiner Integration Studio (DIS)
• Development of connectors (drivers), Automation scripts, SRM functions

• Custom debugging tools

• Import connectors/Automation scripts

• Connector validation

• Etc.

• Available on Dojo: https://community.dataminer.services/exphub-dis/

Visual Studio - DIS
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https://community.dataminer.services/exphub-dis/


Automation script development

• File > New > DataMiner Automation Script Solution

public class Script

{

public void Run(Engine engine)

{

engine.GenerateInformation("Hello world!");

}

}

Visual Studio - DIS
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DevOps
Best Practices

12

Build a collaborative culture

75
DevOps
Points



Git & GitHub

• Git

• https://git-scm.com

• GitHub

• https://github.com/

Source Code Management (SCM)
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https://git-scm.com/
https://github.com/


Git & GitHub
Concepts

14

clone

repository



Git & GitHub
Concepts

15

commit

master
(main)

feature 
branch

master
(main)

feature 
branch

push

fetch/pull



Git & GitHub
Concepts

16

fork
dataminer-docs

SkylineCommunica;ons

dataminer-docs

dataminer-docs

<YourOrganization>

clone

commit

push

pull request

https://github.com/SkylineCommunications/dataminer-docs/


Git & GitHub

• Create organization

• Settings > Organizations > New organization > Free

Source Code Management (SCM)
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Git & GitHub

• Git > Create Git Repository...

Create GitHub repository in Visual Studio
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- Owner: <YourOrganiza;on>
- Public repository



Git & GitHub
GitHub repository

19



Git & GitHub
Git/GitHub integration in Visual Studio

20

• View > Git Changes

• View > Git Repository

• Git

• How Visual Studio makes version control easy with Git

https://learn.microsoft.com/en-us/visualstudio/version-control/git-with-visual-studio?view=vs-2022


DevOps

Adopt continuous integration and deployment (CI/CD)

Best Practices

21

75
DevOps
Points



GitHub Actions

• Automate your build, test, and deployment 
pipeline

• GitHub Actions workflow file

• YAML file (.github/workflows)

• Triggered on repository event

• Consists of jobs

• Job consists of steps (e.g. GitHub Action)

• GitHub Actions marketplace: https://github.com/marketplace?type=actions

• https://github.com/features/actions

Continuous Integration and Continuous Delivery/Deployment (CI/CD)
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https://github.com/marketplace?type=actions


GitHub Actions
Continuous Delivery/Deployment (CD)
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GitHub Actions

• Skyline DataMiner Deploy Action

Continuous Delivery/Deployment (CD)

24

- name: Skyline DataMiner Deploy Action
uses: SkylineCommunications/Skyline-DataMiner-Deploy-Action@v1.0.11
with:
api-key: ${{ secrets.DATAMINER_DEPLOY_KEY }}
solution-path: AutomationScript.sln
artifact-name: EmpowerHelloWorld
version: 1.0.1
timeout: # optional, default is 900
stage: # optional, default is All
artifact-id:
build-number: ${{ github.run_number }}

https://github.com/marketplace/actions/skyline-dataminer-deploy-action


GitHub Actions
Continuous Delivery/Deployment (CD)

25

• Settings > Secrets and variables > Actions



GitHub Actions
Continuous Integration/Continuous Deployment (CI/CD)

26

• Continuous Integration

• Build 

• Unit tests

• SonarCloud code analysis

• etc.

• Starter workflows

• .github/workflow-templates

• https://github.com/SkylineCommunications/Skyline-Starter-Workflows

https://github.com/SkylineCommunications/Skyline-Starter-Workflows


GitHub Actions
Continuous Integration/Continuous Deployment (CI/CD)

27

fork

SkylineCommunications <YourOrganiza;on>

create/update

Skyline-Starter-Workflows Skyline-Starter-Workflows

.github

/workflow-templates

Workflow in Skyline-Starter-Workflows requires personal access token (PAT) with sufficient rights

https://github.com/SkylineCommunications/Skyline-Starter-Workflows
https://github.com/SkylineCommunications/Skyline-Starter-Workflows


GitHub Actions
Continuous Integration/Continuous Deployment (CI/CD)

28

1. Fork repository Skyline-Starter-Workflows

2. In your personal account, create personal access token

• Profile icon > Settings > Developer settings > Personal access token > 
Generate new token

3. Add repository secret “PAT” with token as value

4. Run workflow

5. Merge pull request in .github repository

https://github.com/SkylineCommunications/Skyline-Starter-Workflows


GitHub Actions
Continuous Integration/Continuous Deployment (CI/CD)

29

• Disable “CDOnly” workflow

• Add new workflow



GitHub Actions
Continuous Integration/Continuous Deployment (CI/CD)

30

CI:
uses: SkylineCommunications/_ReusableWorkflows/.github/workflows/Automation Master 

Workflow.yml@main      
with:
referenceName: ${{ github.ref_name }}
runNumber: ${{ github.run_number }}
referenceType: ${{ github.ref_type }}
repository: ${{ github.repository }}
owner: ${{ github.repository_owner }}
sonarCloudProjectName: TODO: Go to 'https://sonarcloud.io/projects/create' and 

create a project. Then enter the id of the project as mentioned in the sonarcloud 
project url here.
secrets:
api-key: ${{ secrets.DATAMINER_DEPLOY_KEY }}
sonarCloudToken: ${{ secrets.SONAR_TOKEN }}



SonarCloud
Code analysis

31

• While logged in on GitHub, browse to https://sonarcloud.io

• Press sign up

• Choose sign up with GitHub

• Authorize SonarCloud

https://sonarcloud.io/


SonarCloud
Code analysis

32

• User Icon > My Account > Security

• Generate token

• Provide token name

• Click Generate

• Copy value

• Create an organization secret in GitHub 

• Name: SONAR_TOKEN

• Value: the token value



SonarCloud
Code analysis

33

• User Icon > My Organizations > <Your Organization>

• Administration > New code



SonarCloud
Code analysis

34

• Click ‘+’ icon (next to user icon) > Analyze new project

• Provide name and key

• Choose Free plan

• Create organization

• Select organization and repository



GitHub Actions
Continuous Integration/Continuous Deployment (CI/CD)

35

CI:
uses: SkylineCommunications/_ReusableWorkflows/.github/workflows/Automation Master 

Workflow.yml@main      
with:
referenceName: ${{ github.ref_name }}
runNumber: ${{ github.run_number }}
referenceType: ${{ github.ref_type }}
repository: ${{ github.repository }}
owner: ${{ github.repository_owner }}
sonarCloudProjectName:<YourProjectId>

secrets:
api-key: ${{ secrets.DATAMINER_DEPLOY_KEY }}
sonarCloudToken: ${{ secrets.SONAR_TOKEN }}



GitHub Actions
Continuous Integration/Continuous Deployment (CI/CD)

36

CD:
if: github.ref_type == 'tag'
environment: production
name: CD
runs-on: ubuntu-latest
needs: CI

steps:
- uses: actions/checkout@v3

- name: Skyline DataMiner Deploy Action
uses: SkylineCommunications/Skyline-DataMiner-Deploy-Action@v1
with:
stage: Deploy
api-key: ${{ secrets.DATAMINER_DEPLOY_KEY }}
artifact-id: ${{ needs.CI.outputs.artifact-id }}



GitHub Actions
Continuous Integration - SonarCloud

37

• Static code analysis

• Quality profiles

• Quality gate



GitHub Actions
Continuous Integration – Unit tests

38

• Test projects in Visual Studio solution

• Code coverage (SonarCloud)

• https://community.dataminer.services/unit-testing-introduced/

https://learn.microsoft.com/en-us/visualstudio/test/getting-started-with-unit-testing?view=vs-2022&tabs=dotnet%2Cmstest


D A T A M I N E R  S C R I P T E D  E X T E N S I B I L I T Y

D A T A M I N E R  S C R I P T E D  E X T E N S I B I L I T Y

Create your first
ChatOps extension,
User Defined API,

and more



DEMO

exercise

DEMO

exercise

Agenda
W H A T ’ S  O N  T H E  M E N U

ChatOps Extensions

User Defined API

Break



Let’s get ready

• Guidelines on questions/help in the session

• Links to docs.dataminer.services

• Links to github repositories

some practical arrangements

HELP!



Let’s get ready

• Interact with DataMiner using other tools in your tool-belt

• Shout-out to the teacher through DataMiner and MS Teams

• Notify a group of colleagues in a MS Teams channel

• Have a conversation with DataMiner using MS Teams

• Expose & consume data through a self defined API

• Control DataMiner objects through a self defined API

goals of session
GOAL

TODO
EARN 150 
POINTS 

IN TOTAL



Let’s get ready

• Install package ‘ChatIntegration Examples’

• Restart Cube session

• Install package “Empower 2023 – DataMiner Scripted Extensibility” 

prepare your DataMiner

You should see at least 
these folders and 

scripts



ChatOps Extensions

6

exerc
ise

DEMO



Microsoft Teams Integration
functionality

7

Notifications ChatOps Automation



Microsoft Teams Integration

• DataMiner

• A cloud-services enabled DataMiner

• Latest version of the Cloud package DxM

• MS Teams server

• Make sure the DataMiner Bot is visible for install in the teams-client

• Provide admin consent if you want DataMiner to allow sending notifications

• MS Teams client

• Auto-installed when added into conversation

• If not installed yet, install bot from store if you want to interact directly with your DataMiner

the building blocks

8



Notifications
how notifications get to you

9

DataMiner Cluster DataMiner Cloud Your Teams Environment

Your Clusters are part 
of a Cloud 

Organization

Grant consent, to link 
a DataMiner 

Organization to your 
Teams Tenant



Notifications Connection
one time setup

10

What your IT approvesadmin.dataminer.services
1

2

3

Confirm the linking
4

What you will 
probably see

Ready to Team

5



ChatOps
how you get to your dataminer from MS Teams

11
DataMiner Cluster A

DataMiner Cloud

The bot is 
connected to 

DataMiner Cloud 
Services

Staging
DataMiner Cluster

DataMiner Cluster B

The user selects a 
DataMiner Cluster 

to connect to



Chatbot Connection
one time setup

12

In MS Teams search 
the DataMiner App

1

2
Add to your 
Teams

Ready to chat

3

Make sure your 
accounts are linked on 

dataminer.services
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dataminer.services
1

overview page
2

specify user to login
on the DataMiner Cluster

3

confirm summary

4

all set

5



Notifications

• Prepared in scripts

• Fetch the connection ID of the destination (STEP 1: Prepare setup)

• Send the Message to the destination (STEP 2: Send)

• Send direct message to baptiste.pattyn@skyline.be

Shout-out to your trainer through DataMiner and MS Teams

14

exerc
ise

direct message

mailto:baptiste.pattyn@skyline.be


Notifications
Shout-out to your room-mates through DataMiner and MS Teams

15

Prepare setup ‘Fetch Private Chat Example’
- Select destination
- Select ChatsExample (which is a memory file)

1
Execute ‘Send Chat Notification Example’

2 3
Visible in MS Teams



Notifications

• Send a message to a pre-defined Teams-channel

• Actions

• Change script “Alarm actions.Take Ownership”

• uncomment  //SendChannelNotification(notification);

• Specify your name

• Generate an alarm on “SLC HQ SW-L01” the interface by disconnecting a port

• Run command “Hyperlinks > Take Ownership” on the alarm, which result in

• Notify the team

• Acknowledge the alarm

inform your team on an event in DataMiner

16

Team message in 
specific channel

TODO

EARN
75 POINTS

exerc
ise



Notifications
inform your team on an event in DataMiner

17

exerc
ise

Generate alarm on switch. (Info: There is conditional monitoring 
configured based on the ‘Physical connection’)

1

- Un-comment the SendChannelNotification call, and hit save.
- Specify your name
(You should do this through your CI/CD pipeline and DIS ;-) )

2



Notifications
inform your team on an event in DataMiner

18

DONE

EARNED 
75 POINTS

exerc
ise

Trigger the script by executing hyperlink on the generated alarm

3

Visible in Teams
4



Notifications

• These were some examples

• Can be triggered from many places

• Find a use-case in your organization

• Teams channel for NOC users

• Emergency channel

• Company-wide channel on which you want to regularly post some information

• …

• Can be an activity in a process

find your business flow

19



Bot and its built-in commands

• Built-in commands

• If you have a DataMiner Bot, feel free to join along

• Demo on commands

• Help

• Change DMS

• Show view/element/service/…

chat chat chat …

20

Use MS Teams to 
interact with any 

DataMiner System

DEMO



Bot and custom commands

• Specific scripts in ‘bot’ folder

• Trainer executes custom command

21

DEMO



22



More options

• Adaptive cards Overview of Adaptive Cards for Teams - Power Automate | Microsoft Learn

you can do even more

23

https://learn.microsoft.com/en-us/power-automate/overview-adaptive-cards


User Defined APIs

24

exerc
ise

DEMO



User Defined APIs

25

create  tailored 
User-defined API 
easily & quickly

deploy
on the fly in line 

with your 
workflows

create secure 
platform to 

platform 
connections

evolve easily & 
continuously



User Defined APIs
Telenor Use Case – TV Diagnostics API

26

• DataMiner EPM Solution deployed at Telenor monitors the delivery of its TV channels via DVB-C, 
IPTV, OTT and FWA 24/7

• A user defined API - which is consumed by an in-house developed customer support tool – provides 
detailed diagnostics data to Telenor's Customer Support Team

•From Infrastructure, Device and Channel point of view

•Live or Historical

• A Telenor Support Engineer only has to enter the customer id into the tool, and will receive all 
relevant data within a few seconds

• A DataMiner Dashboard is keeping track of the API request rate and performance



User Defined APIs
Telenor Use Case – TV Diagnostics API

27



User Defined APIs

• Create an api from existing script

• Publish API

• Define URL

• https://<host>/api/custom/<route>

• Create tokens

• Use postman to test the API

Expose & consume data through a self defined API

28

TODO

EARN
75 POINTS

exerc
ise



29

Select the available script
‘Switch Status’

1

Uncomment the entry point 
and hit save.

2

Configure the API

3

exerc
ise



30

exerc
ise

Define the url

1

Create a token

2



31

DONE
EARNED

75 POINTS

exerc
ise

Configure request in postman
- GET
- URL prefixed with your domain on 

dataminer.services
- Authorization header: Bearer + <created token>

1

Hit ‘send’ and see the HTTP “200 OK”
2



User Defined APIs
debug an error

32

If things go wrong:
- Check the HTTP error
- Check the Error code in the JSON

1

Look up the 2 error-codes in 
docs.dataminer.services

If you get this error during the exercise, 
you probably forgot to modify and save 
your script.

2



User Defined APIs
Control your DataMiner through an API

33

Option to filter on HTTP-VERB

1

You can reuse tokens, so you can 
provide the consumer a nice set of 
API-calls

2

exerc
ise



User Defined APIs
Control your DataMiner through an API

34

All ports down
2

Configure postman to do
- POST
- On the created URL
- Authorization token
- Should result in an HTTP OK

1



D A S H B O A R D S  &  L O W - C O D E  A P P S

D A S H B O A R D S  &  L O W - C O D E  A P P S

Reimagine

how things       can be done

with your first

dashboards & low-code apps



Agenda
W H A T ’ S  O N  T H E  M E N U

Dashboards: real-time operational insights for everyone

• Concept

• Components and Data Sources

• Build your own server dashboard

• Leverage feeds to make our dashboards dynamic and reusable

• Share a live dashboard

Low-code Apps: take it to the next level 

• Concept and difference with dashboards

• Build your first app

• Expand an app with a collapsible side-panel

(09h00 – 10h30)

25

75

50



Make sure you have the Generic Switches elements available

If not:
• Go to ‘catalog.dataminer.services’
• Search for ‘Empower 2023 - DataMiner Scripted Extensibility’ & deploy



DataMiner Dashboards

Visualize any data

Drag-and-drop dashboard design 

Library of visualizations

Query and analyze with GQI

Customizable themes

Full DataMiner security enforced

Additional access control

Generate reports

…

Real-time operational insights for everyone



DataMiner Dashboards
Real-time operational insights for everyone

Real-&me updates

Monitor parameter 
changes as they happen

Live sharing with anyone
Through secure 

connection via DataMiner 
Cloud Platform

Tailored visualiza&ons

Visualize alarm states, trend 
charts, node edge graphs, 

maps, schedules, …

Seamless mobile experience

All dashboards are available 
through mobile web 

browsers as well, opAmized 
for mobile formats



Dashboards

6

https://ziine.skyline.be/dashboard/

https://ziine.skyline.be/dashboard/


Build Your 
Own 

Dashboard

7

Go to your own 
DataMiner agent



Dashboard end goal
see sample dashboard “Server Dashboard” on your own DMA

8



Build Your Own Dashboard

1. Click on Dashboards

2. To create a new dashboard click on the three dots in left column  

3. Give the dashboard a name like “Infrastructure”

4. Select security level “every user can view and edit”

Create new dashboard

9



Build Your Own Dashboard

• First choose a style using Dashboard Themes

• Click on layout in the right pane

• Select the ‘Empower’ theme

Dashboard Themes

10



Build Your Own Dashboard

• Drag and drop the Image visualization from the left pane on to the dashboard

• On the right pane,  go to settings and select the logo.png image 

• Set the style of the component to Transparent

Adding an image

11



Build Your Own Dashboard

Using a Text component

• Drag and drop text component

• On settings enter Text = “Server 
Dashboard <ENTER> Microsoft platform”

• On layout

• Font size = 27

• Style > select ‘Yellow’ from theme

Adding a Title

12

Using an HTML component

• Drag and drop an HTML component

• On Settings : 

• Type = Custom HTML

• HTML =

• On Layout:  Style > select ‘Yellow’ from theme

<H1
style="color:#000000; font-family: 'Segoe UI Light', sans-serif;margin:0;font-
weight:200; padding-left:10px;">
<b>Server Dashboard</b>
<div style="font-size: 20pt"><img
src="https://upload.wikimedia.org/wikipedia/commons/4/44/Microsoft_logo.svg
" width="22px" />&nbsp;Microsoft Platform
</div>
</H1>



Build Your Own Dashboard
Visuals, Data and Components

13

Visualization

Data source

Component



Visualizations

• Drop the data source on the dashboard canvas

• Hover the component, and in the popup click the ‘visualization’ 
button 

• You will see a filtered set of possible visualizations

• Hovering each visualization will show a preview

Find the right visualization for your data

14



Visualizations

• Also other way around

• Drop a visualization on the canvas

• Click on the green ‘data’ or yellow ‘filter’ drop zone

• Compatible data types will be highlighted

• Specific data sources that can be used with this visualization 
are indicated with a        or       icon

Find the right visualization for your data

15



Add an element

• Open the data tab

• From the data sources, open the Elements expander

• Choose an element from the element selector, e.g. localhost

• Drag this element onto the dashboard  canvas

Add the data source

16

1

2

3



Add an element (as State)

1. Hover the component, and in the popup click the 
‘visualization’ button 

• You will see a filtered set of possible visualizations

• Hovering each visualization will show a preview

2. Choose a visualization, e.g. ‘State’

3. Position and resize as you wish

4. Tune visuals

• Layout > Style > design = Auto size

• Layout > Styles > select “Blue”

• Alarm state coloring = Line

Choose a visualization

17

Result



Add an element (as State timeline)

1. Drag and drop the same element again on the dashboard

2. Now choose a visualization  ‘State timeline’

3. Position and resize as you wish

•

Choose a visualization

18

Result



Add a parameter (as State)

1. From the same element select the parameter “Performance > Device 
Info > Computer Name” and add it to the dashboard

2. Choose the visualization State

3. Tune visuals

• Set Title = “ Computer Name”

• Layout > Style > design = Auto size

• Layout > Labels > disable “show parameter name”

• Layout > Styles > select “Blue”

19

Exercise

Result

Add state components for parameters: System Type, 
Model, Days since last reboot. Each with a different color



Add a parameter

• Open the data tab

• From the data sources, open the Parameters expander

• Leave the ‘from’ selector as it is to use an element

• Choose an element from the element selector, e.g. localhost

• Choose the desired parameter, e.g. Total Processor Load (under 
Performance)

• Drag this parameter onto the dashboard  canvas

Add the data source

20

1

2
3
4

5



Add a parameter (as Gauge)

1. Hover the component, and in the popup click the 
‘visualization’ button 

• You will see a filtered set of possible visualizations

• Hovering each visualization will show a preview

2. Choose a visualization, e.g. ‘Gauge’

3. Position and resize as you wish

4. Tune visuals

• Layout > Style > design = Auto size

• Disable Labels > Show parameter name

• Set Title = “ Processor Load”

• Add additional gauge for Physical Memory Usage

Choose a visualization

21

Exercise

Result



Add a trended parameter (as Line & area chart)

1. Drag and drop the trended parameter “Total Processor 
Load” onto the dashboard canvas

2. Choose the visualization ‘Line & area chart’ 

3. Tune visuals

Choose a visualization

22

Exercise

Result

Add a seconded trended parameter Physical Memory Usage
to the same Line & area chart



Add a trended parameter (as Trend statistics)

1. Drag and drop the trended parameter “Total Processor 
Load” onto the dashboard canvas

2. Choose the visualization ‘Trend Statistics’ 

3. Tune visuals

23

Result



1. From the visualizations drag and drop an ‘Alarm table’ onto 
the dashboard canvas

2. To filter on alarms of a specific element (localhost), drag 
and drop the element onto the alarm table 

Add an alarm table

24

Result



Add a parameter table

1. From the visualizations drag and drop an ‘Parameter table’ 
onto the dashboard canvas

2. From Data sources, drag and drop the parameter “Task 
Manager” (from element localhost) onto the parameter 
table

3. To only show specific columns, drag and drop the columns 
from the data source (under task manager) onto the 
parameter table

25

Result



Making your 
dashboard 
interactive

26

Using feeds



Data sources

1. Out-of-the box data sources
Pre-defined DataMiner data types

Drag and drop
Updating in real-time

Different flavors for different applications 

27



Data sources

1. Out-of-the box data sources
Pre-defined DataMiner data types

Drag and drop
Updating in real-time

2. Feeds
Data coming from a selection in another component

Used to make content of dashboards dynamic

Different flavors for different applications 

28



Data sources

1. Out-of-the box data sources
Pre-defined DataMiner data types

Drag and drop
Updating in real-time

2. Feeds
Data coming from a selection in another component

Used to make content of dashboards dynamic

3. Queries
Any data source

Build advanced queries
Filter, aggregate and combine data

Updating on refresh

Different flavors for different applications 

29



Data sources
Different flavors for different applications 

30

1. Out-of-the box data sources
Pre-defined DataMiner data types

Drag and drop
Updating in real-time

2. Feeds
Data coming from a selection in another component

Used to make content of dashboards dynamic

3. Queries
Any data source

Build advanced queries
Filter, aggregate and combine data

Updating on refresh



Interactivity – Using feeds
Show parameters based on user selection

31

1

2



Interactivity – Using feeds

1. Drag Elements header onto dashboard

2. Choose visualization = dropdown

3. To filter on Generic Switch elements only

à From protocol drag and drop Generic Switch onto the drop down 

1) Make an element pick list

32

Result



Interactivity – Using feeds

1. From ‘Data’, drag the following parameter onto the canvas:

• Parameters > From Protocol >  Generic Switch’

• Parameter > User Idle CPU %, 

2. Choose visualization = Gauge

3. To only show this parameter for element selected in dropdown:

à From Feeds drag and drop Dropdown 1 > Elements onto the gauge

4. Add parameters to the same gauge component: Memory Usage

• Make sure following settings are set on tab LAYOUT > Advanced >  Layout:

• Layout flow = ‘Rows’ / Maximum columns per page >= 5

2) Based on element selection show parameters

33

Result



Interactivity – Using feeds

1. From Visualizations drag and drop “Line & Area chart”              onto dashboard

2. Drag and drop Feeds> Gauge >Parameters onto the Line & Area chart

3. Now when selecting a CPU gauge it will update 
the line chart with the CPU trend info

3) Based on parameter selection trigger other component

34

Result



Add a Time range 

1. Drag and drop the Time range visualization onto the 
dashboard canvas

2. On layout enable Use quick picks and disable show current 
range

3. On the line charts à drag and drop Feeds >Time 
range>Timespans. This will now update the time ranges on 
the line charts when the time range filter options are used

35

Result



Secure your dashboard

• DataMiner security enforced in dashboards by default: users only see metrics they have rights to

• Further limit access to a dashboard:

• Without components selected, go to settings

• Under user access, you can specify the users

• As soon as you start typing, a list of users and groups is shown

36



Dashboard sharing

• Instant, effortless and on the fly

• Fully configurable and easily 
manageable

• Supporting concurrent sharing towards 
multiple people

• Option to add a message for your 
“addressees” as well as an expiration data

• Straightforward to add or remove someone 
to your list

• Revocable at any time

• Email notification with link to the 
dashboard sent out automatically 

Collaborate around your data with anyone in- or outside of your organization

37© 2023 Skyline Communications



Share your dashboard in the cloud

1. Click the 3 dots

2. Click share

3. Click create cloud share

• Possibly you need to allow popups to go to the next step

4. Log in or register and link accounts if needed

5. Fill in the sharing data and share

• Include your own e-mail address

38

75 DevOps points!



D A S H B O A R D S  &  L O W - C O D E  A P P S

D A S H B O A R D S  &  L O W - C O D E  A P P S

Take it 

to the next level

with low-code apps



DataMiner Low-Code Apps
Focus on the essentials to do better

Build apps fast
Build – deploy – use in minutes 

regardless of your coding abili:es

Plug in DataMiner automation 
scripts to further boost your apps 

for any use case

Leverage powerful 
DataMiner automation

Collaborate without limits
Share apps for live monitoring & 

control with anyone inside or outside 
(roadmap) of your organiza:on 

securely

Tools are built by the people who 
need to use them day in and day 

out.

Empower everyone to 
create



Dashboards vs            Low-code apps

• Any data source

• Catalog of visual components

• One page

• Mainly for monitoring & reporting

• Limited in actions

• Live sharing

• Export to PDF/Email

• Any data source

• Catalog of visual components

• Multiple pages and collapsible panels

• Infinite use cases

• Automation & user interaction

• Live sharing: on the roadmap

• Versioning

41



D A S H B O A R D S  &  L O W - C O D E  A P P S

D A S H B O A R D S  &  L O W - C O D E  A P P S

Some examples



Low-code apps

• Create a new app: hover your mouse next to ‘Monitoring’ and click the         button that appears

• Give the app a name: “Hello World”

• Choose an icon for your app

• Create a couple of pages (“Switches”, “Page 2”, “Page 3”, …)

• Choose some page icons you like

• Play around with the ordering + visibility of pages

•
• Publish your app and check it out!

Create you first app

43

25 DevOps points!



Low-code apps

• Create the same interactive dashboard in the App.

• Go into edit mode

• Create a new panel called ‘Interfaces’

• Add a Parameter Table component to it

• Data: Protocol parameter ‘Interfaces’ from ‘Generic Switch’ protocol

• Filter: element feed from dropdown on Main page

Adding content in a collapsible side panel

44



Low-code apps

• Go into edit mode

• Activate the header bar on the ‘Switches’ page

• Add a button that says ‘Show Interfaces’

Adding content in a collapsible side panel

45



Low-code apps

• Go back to button on the ‘Swicthes’ page and add an event to it

• On click: open a panel

• Panel: ‘Interfaces’

• On the right

• Width: 30%

Publish your app and test your button!

Adding content in a collapsible side panel

46

75 DevOps points!



Actions in Low-Code Apps
Many different possibilities

47

General actions Component actions

Link to full documentation

https://docs.dataminer.services/user-guide/Advanced_Modules/Application_framework/Low-Code_Apps_configuration/LowCodeApps_event_config.html


Actions
Execution types

48

In parallel In sequence



Actions

• On page load

• On button click

• On page

• On header

• On component specific trigger

• Table

• On row click

• On row double click

• On row button click

• Node edge

• Schedule 

• Grid

Possible triggers

49



D A T A M I N E R  O B J E C T  M O D E L L I N G

D A T A M I N E R  O B J E C T  M O D E L L I N G

and shape 
Create 

your first DataMiner

Object Model



Agenda
W H A T ’ S  O N  T H E  M E N U

• Introduction 

• Use cases

• DevOps tools to create/update DOM definitions

• DOM architecture & possibilities 

• Hands-on #1

• Create DOM definition with DOM designer (Excel)

• Extend DOM definition with DOM Editor

• Code example: Invoices App

• Best practices

• Hands-on #2

• Creation of a Low-Code-App centered around DOM

75 DevOps
Points

75 DevOps
Points



Enrich your operation with just any administrative data

3

Object modelling (DOM)

• Empower endless business and operational use cases

• Channels, assets, tickets, people, and many more

• Customize lists & forms for whatever your team needs

• Create your data model with highly tailored forms to enter/store data in your app

• Low-code object modelling & IaC

• Self-documented environment

• Combine with Low-code apps or 3rd party systems

• Create persona-specific apps on top of DOM for a personalized experience

• Visualize DOM data in timelines, bar charts, pie charts and many more

• Data easily accessible by DataMiner modules and 3rd party systems

• Add behavior and automation to your data

• State-aware objects with managed state-transitions

• Enables controlled and step-wise data collection and completion

• Automate business operational & technical processes & logic on top of the data



Enrich your operation with just any administrative data

4

Object modelling (DOM)

• Event administration

• Event customer portals

• Vehicle resource management

• …

• Asset management

• RPD provisioning

• Planned maintenance

• Ticketing

• People and organizations

• Human resource scheduling

• Virtual desk management

• …



Continuously improve your data models 
you build it, you run it

low code apps

Semi-manual 
on-cluster 

deployment

CI-CD pipeline

today

roadmap

DOM definition in excelDOM scripts DOM Editor

DOM definition (graphical)

DOM models & forms



D A T A M I N E R  O B J E C T  M O D E L L I N G

D A T A M I N E R  O B J E C T  M O D E L L I N G

DOM

Architecture



Module vs definition

7

DOM

IPTV channel

ID

Video format

Type

General

IP info
Multicast group IP

Multicast source IP

Multicast port

text

HD/SD

ASI/SDI/IP/SAT

text

text

number

Channel

Sat channel

General

Satellite info
Frequency

Symbol rate

Polariza>on

number

text

H/V

ID

Video format

Type

text

HD/SD

ASI/SDI/IP/SAT

Module

Definition

Defini-on

Module ID

Settings

Mandatory sections

Sec-on

Section

Section

Section

Scripts



Definition vs Instance

8

DOM

Professional

IPTV Channel instance

ID: Discovery channel

Video format: HD

Type : IP

General

M group IP: 293.105.13.1   

M source IP: 172.26.248.93

MulMcast port: 13001

Definition

Instance

Instance

Instance

IPTV Channel defini3on

ID

Video format

Type

General

IP info
Multicast group IP

Mul>cast source IP

Mul>cast port

text

HD/SD

ASI/SDI/IP/SAT

text

text

number

Sec-on

IP info

IPTV Channel instance

ID: Animal Planet

Video format: SD

Type : IP

General

M group IP: 239.105.13.1   

M source IP: 172.26.210.93

MulMcast port: 13010

IPTV Channel instance

ID: MTV

Video format: HD

Type : IP

General

M group IP: 293.105.13.2   

M source IP: 172.26.248.94

MulMcast port: 13002



DOM

• Standard

• String

• Double

• Long

• DateTime

• TimeSpan

• Bool

• Enum

Field descriptors

9

• DataMiner specific

• Resource

• Element

• Service definition

• DOM instance

• DOM instance value

• Roadmap

• User/user group

• Time range

• Email

• IP

• MAC

• Attachments

• …

h'ps://docs.dataminer.services/user-
guide/Advanced_Modules/DOM/DOM_objects/DOM_SecDonDefiniDon.html

DateTime

DOM instance

Bools

https://docs.dataminer.services/user-guide/Advanced_Modules/DOM/DOM_objects/DOM_SectionDefinition.html
https://docs.dataminer.services/user-guide/Advanced_Modules/DOM/DOM_objects/DOM_SectionDefinition.html


• Define for each state:

• Which fields are mandatory/optional

• Which fields are visible/hidden

• Which fields are read-only

• Which buttons are visible on the form

• Buttons can trigger custom automation

DOM
State-aware objects with managed state-transitions

Task

Title: Reboot server

Descrip-on: 
Reboot all airspeed 
servers in CAR5

General

State: Request

Task

Title: Reboot server

Description: 
Reboot all airspeed servers in 
CAR5

General

State: Scheduled

Request In progress Done

Due date: Q2 2023

Scheduled

Task Task

Assigned to: John Doe

Title: Reboot server

Description: 
Reboot all airspeed servers in 
CAR5

General

State: Scheduled

Due date: Q2 2023

Assigned to: John Doe

Comments: implemented 
a workaround that fixed the 
issue 

Title: Reboot server

Descrip-on: 
Reboot all airspeed servers in 
CAR5

General

State: Scheduled

Due date: Q2 2023

Assigned to: John Doe

Comments: implemented 
a workaround that fixed the 
issue 

Schedule task

Set in progress

Finish

10



DOM

• Define transitions between states

• Trigger transitions on instances via 
automation

• Manual via a form button 

• External API trigger 

• e.g. 

• When a booking ends

• In a process activity

State transitions

11

New Approved In progressWaiting for approval

Rejected

Done

new_to_waiting for approval

waiting for approval_to_rejected

waiting for approval_to_approved

approved_to_in progress

in progress_to_done
waiting for approval_to_new



DOM instance

12

Lifecycle & script execution of instance

Task

Title: Reboot server

Descrip-on: 
Reboot all airspeed 
servers in CAR5

General

State: Request

Task

Title: Reboot server

Description: 
Reboot all airspeed 
servers in CAR5

General

State: Scheduled

Request In progress Done

Due date: Q2 2023

Scheduled

Task

Title: Reboot server

Description: 
Reboot all airspeed 
servers in CAR5

General

State: In progress

Due date: Q2 2023

Task

Title: Reboot server

Description: 
Reboot all airspeed 
servers in CAR5

General

State: Done

Due date: Q2 2023

Schedule task Set in progress Finish

Create script Update script Update script Update script

Ac-on script Ac-on script Action script

Task

Title: 

Description:
 

SaveGeneral

On create

Reboot server

Reboot all airspeed 
servers in CAR5

Due date: Q2 2023



D A T A M I N E R  O B J E C T  M O D E L L I N G

D A T A M I N E R  O B J E C T  M O D E L L I N G

Hands-on



Hands-on

• Installa3on of:
• Product Catalog App

• People and Organizations App

• Scripts used during hands-on

• Generate resources used during hands-on

• Steps
• Open Catalog

• Search for DOM

• Deploy InitialSetup package

• Deploy Hands-on package

• Deploy DOM Editor package

Install Prerequisite package

14



G E T  I N S P I R E D

G E T  I N S P I R E D

Ziine is a visionary B2B services company, offering top-of-the-line Prestige 
services to customers on demand. Prestige is a platform service used by 
customers of Ziine to analyze their business from time to time. Ziine has made 
different packages available based on the performance requirements : Prestige 
Enterprise, Prestige Pro and Prestige Light. To make a seamless experience, the 
Ziine sales team has created an online portal, that allows to manage Prestige 
service orders with ease. This portal can be accessed through any web browser. 
Schedule orders by selecting a package, customer and a desired time-interval. 



Hands-on
Goal

16

Order ID

ServiceOrder
Order details

String

Description String

Start time DateTime

End time DateTime

catalog

Server location Enum

Organization DomInstance

Enterprise name

Organization
Contact

String

Street address String

City String

ZIP Long

(p&o)organizations

Country Enum

Category Enum

Email String

Email String



Hands-on
Goal

17

Order ID

ServiceOrder
Order details

String

Description String

Start time DateTime

End time DateTime

catalog

Server location Enum

Organization DomInstance

Enterprise name

Organization
Contact

String

Street address String

City String

ZIP Long

(p&o)organizations

Country Enum

Category Enum

Email String

Email String

InitialSetup package



Hands-on
Goal

18

Order ID

ServiceOrder
Order details

String

Description String

Start time DateTime

End time DateTime

catalog

Server location Enum

Organization DomInstance

Enterprise name

Organization
Contact

String

Street address String

City String

ZIP Long

(p&o)organizations

Country Enum

Category Enum

Email String

Email String

DOM Editor tool



Extra exercises

1. Execute the Dom Editor script

2. Add a new Definition ‘Service Order’ within the 
(p&o)organizations module

3. Add a new Section Definition ‘Order Details’

4. Add the listed Field Descriptors to the ‘Order Details’

5. Section Definition

6. Add the ‘Order Details’ Section Definition to the ‘Server Order’ 
Definition

DOM editor

19

75 DevOps
Points



Extra exercises

• Refresh the app & field should be added

DOM editor

20



Code example

• DataMiner Docs: 

• Go to https://docs.dataminer.services/

• Search for ‘Invoice App’

• Open the ‘Invoice app example’ page

• Content

• Creating the section definitions

• Adding the DOM definition

• Creating DOM instances

• ...

Invoices App

21

https://docs.dataminer.services/


Best practices

• Reduce the amount of DOM modules. Group DOM definitions that belong together in one manager.

DOM modules                  DB indexes               memory and compute requirements

• Avoid large objects. Split them up if pieces of data are rarely used together.

• Large objects take longer to be transferred between server and client.

22



D A T A M I N E R  O B J E C T  M O D E L L I N G

D A T A M I N E R  O B J E C T  M O D E L L I N G

DOM
Integration in low-code 

apps



Hands-on

• Milestone 1: basic app with a button to create a new DOM instance

• Create a new app

• Show instances in table

• Add button to expand panel

• Add panel with form

• Add save button

DOM integration in low-code apps – milestone 1



Hands-on

• Milestone 2: expand the app with a table that shows all orders & have the possibility to show/edit existing instances

• Add button to expand panel from table

• Feed form in panel with table

• Add refresh actions from save

• Add delete option on the form

DOM integration in low-code apps – milestone 2

25



Hands-on

• Milestone 3: polish app

• Show filtering on a table

• Add conditional coloring on DOM table

• Customize columns per user by drag & drop

• Add extra pages

• Change layout

• Add image

DOM integration in low-code apps – milestone 3

26



G E N E R I C  Q U E R Y  I N T E R F A C E  ( G Q I )

G E N E R I C  Q U E R Y  I N T E R F A C E  ( G Q I )

Craft your first
GQI queries

and    deliver your first

actionable insights



Agenda
W H A T ’ S  O N  T H E  M E N U

• What is GQI?

• What are queries?

• How does data flow?

• Visualizing a result

• Simple

• Advanced

• Tweaking a query

• Extending GQI

• Ad hoc data sources

• Custom operators



We can visualize 
results.

50

We can use data 
sources and 
operators.

50

Goals

3

We understand 
the concept of 

GQI and queries.

We can extend 
GQI.

50

We understand 
how data is 

flowing.



What is GQI?
Ssssh, it’s magic…

4



What is GQI?

Generic Query Interface

Why?

• Fetches tables

• Abstraction layer for 
dashboards and Low-Code apps

• Generic operators

• Generic visualizations

• Generic tools

5

Query builder and filter



What are queries?
You talking to me?

6



What are queries?

Similarities with other querying languages

Exists of

• One data source

• Zero or more operators

Built through a conversational API

Stored in your dashboard or Low-Code app

7



What are queries?

Identifies what data should be fetched

8

Data sources you say?

Alarms

Bookings

DOM instances

Parameters

Services

DataMiner

API endpoint

Database

File storage 
(CSV, JSON, XML)

Any external data



What are queries?

Chained operators that apply transformations to our data source

9

Operators you say?



What are queries?

Looks at the current query and limits capabilities to what makes sense.

10

Conversational, my new best friend?

Text Numeric



G E T  I N S P I R E D

G E T  I N S P I R E D

Let’s have
a look

We understand 
the concept of 

GQI and queries.



Hands-on time!
• Go to ‘Catalog.dataminer.services’
• Search for ‘GQI’
• Install the ‘Empower 2023 – GQI – Hands-on’



Let’s get our hands dirty!

Query exercises

We can use data 
sources and 
operators.

50



How does data flow?
Like a stream of 1s and 0s

14



How does data flow?

15

Sessions!

Runs in the browser 
on the client.

Request

Response

Runs in the SLHelper 
process on the DMA.

Depends on the 
data source

Request

Response

Advanced!



How does data flow?

OpenQuerySession

• Sends a request to open a session

• Returns session key, column information

GetNextQuerySessionPage

• Sends a request for the next X records

• Returns the next X records

• Rinse and repeat

CloseQuerySession

• Sends a request to close the session and release the resources on the backend

• Returns nothing

16

Messages?

We can use data 
sources and 
operators.

Advanced!



Visualizing a result?
Please, no more tables...

17



Visualizing a result

18

Well known visuals

Table Bar chart Pie chart Line chart State



Visualizing a result

19

Advanced visuals - Grid
Soft-launch



Visualizing a result

20

Advanced visuals - Timeline
Soft-launch



Visualizing a result

21

Advanced visuals – Node-edge



Visualizing a result

22

Advanced visuals – Maps
Soft-launch



Let’s get our hands dirty!

Visual exercises

We can visualize 
results.

50



Tweaking a query
Less is more

24



Tweaking a query

Right click menu of columns.

25

Through a table



Tweaking a query

Separate component

Exposes other queries

Exposes statistics

26

Through a query filter
Soft-launch



G E T  I N S P I R E D

G E T  I N S P I R E D

Let’s have
a look



Extending GQI
You mean extending it ourselves?

28



Extending GQI

Not all data is in DataMiner yet

• File based storage

• Databases

• Rest APIs

We needed a flexible and easy way to access any data

Queried only when necessary while retrieving the latest values

29

Ad hoc data sources - Why

Advanced!



Extending GQI

• Write code that implements one or more interfaces

• Compile this class in a library using the automation module

• The data source will automatically become available in the query builder

30

Ad hoc data sources - How

Advanced!



Extending GQI

Do your own transformations using custom operators!

Similar approach to ad hoc data sources:

• New set of interfaces

• Compiled as a library

• Automatically available in the query builder

31

Custom operators
Advanced & soft-launch!



Let’s get our hands dirty!

GQI extensions

We can extend 
GQI.

50



G E N E R I C  Q U E R Y  I N T E R F A C E  ( G Q I )

G E N E R I C  Q U E R Y  I N T E R F A C E  ( G Q I )

When it all
comes together



Goals

34

Increment 2
(Optional)

(deadline April 5th)

50

Increment 1
(Op3onal)

(deadline April 5th)

50

MVP
(Goal of today)

50



Let’s create an app
Here’s the story…

35

Get ready for an exci/ng project, folks! We have the incredible opportunity to create a game-changing tool that will empower our amazing 
manager, Andi Tamer! Andi will be blown away by the insighCul informa/on we'll be providing about our orders, including new orders, wai/ng 
orders, and those that are ready to be delivered. We can't wait to see Andi's face light up with apprecia/on when we receive 50 DevOps Points 
for our hard work!

But that's just the beginning, because we're taking this project to the next level! A;er Andi's review, we'll be adding even more features to our 
tool. We'll be providing insights on the revenue we're generaAng with our services and show how much revenue an order generates. Andi has 
requested an extra page that shows our orders in a nice schedule view, and another page that provides details on our operaAons, like how many 
people are part of our company and what level of experAse they are grouped in. And guess what? Andi will reward us with 50 DevOps Points for 
this incredible work!

But wait, there's more! Our ulAmate goal at Ziine is to generate $1,000,000 in revenue with these services in 2023, and Andi wants to know if 
we're on track. Can we get some insights on that in the app? Andi also wants to know how happy our customers are with our services. We'll even 
create a landing page for Andi's app, which will give him a summary view of all the content in the app. And if we can create this last increment, 
Andi will reward us with another whopping 50 extra DevOps Points!

Today, we'll create the MVP and if you're feeling empowered, go ahead and take the lead on the next itera/ons! Andi has set the deadline on 
April 5th for us to send him a demo of the final version (andi.tamer@skyline.be). So, let's roll up our sleeves, put our best foot forward, and 
create an app that will make Andi proud! This is an exci/ng opportunity to showcase our skills and make a real impact on our company's 
success!



Let’s create an app
Focus on an MVP version

36



Let’s create an app
Feel free to go wild

37



G E T  I N S P I R E D

G E T  I N S P I R E D

Real-life      use cases
from

around the  world



G E T  I N S P I R E D

G E T  I N S P I R E D

Create quick    wins



practical 
details

L E T  U S  E M P O W E R  Y O U



better - faster - cheaper
towards a data driven organization

plan

deploy 

monitor

control

automate & orchestrate

your unique ecosystem, without boundaries

Digital Twin

Live Sharing as a Service

ChatOps as a Service

DevOps as a Service

Unsupervised (real-time) AI

Business Process Automation

Service & SLA Monitoring

Collaboration

Ad-hoc control management

Configuration Management

Life-cycle management

Event management

Incident management

Service configuration planning

…

[AI]



DataMiner comes with sample applications and
use cases for ICT media & broadband

Markets

production studio  •   MCR  •  playouts  •  multi-screen OTT  •  video 
headends •  cloud pipelines  •  SaaS  •  cloud platforms  •  ICT data centers  
•  ad insertion  •  VoD pipelines  •  Media Asset Management WF 
automation MAM  •  EPG meta data management   •  IP L3 networks  •  IP L2 
VLAN networks  •  MPLS networks  •  SDH & SONET networks  •  CDN 
networks  •  optical networks  •  broadcast SNG  •  contribution & exchange 
networks  •  inter- studio networks  •  core backbones  •  DTH  •  DVB-T  •  
ISDB-T  •  ATSC networks  • enterprise VSAT  •  consumer VSAT  •  satellite 
teleports  •  satellite downlinks  •  GEO networks  •  MEO and LEO 
constellations •  DOCSIS networks  •  DSL access networks  •  4G/5G fixed 
mobile networks  •  FTTx networks  •  5G RAN  •  5G broadcast  •  CDN  •  IoT  •  
EPG metadata  •  CPE broadband gate fixed wireless  •  CPE Mobile  •  WiFi
networks  •  KQI management  •  ticket and incident management  •  
incident resolution  •  inventory management  •  planned maintenance 
management  • facility management  •  rack management  •  configuration 
management  •  software management  •  BPM business process 
management    …

Solutions Use Cases DataMiner

https://community.dataminer.services/solutions/
https://community.dataminer.services/use-cases/


What we offer

6 © 2023 Skyline Communications

usage-based

perpetual-use
licenses

pay-per-use

subscription

Commercial Model

self-hosted
Onprem / private cloud / hybrid

StaaS

self-hosted

DM Storage

DaaS

Hosting

public cloud



Agenda
W H A T ’ S  O N  T H E  M E N U

ICT

1. Environmental, facilities & IoT sensors

2. On-premises networks & data centers

3. Network timing management

4. Managing cloud workloads

Events and jobs planning

5. Events and jobs bookings

6. Production workloads in the cloud

Master Control (MCR)

7. Flow and signal group management

8. Flow engineering & documentation

9. Flow monitoring

10. Control surfaces

11. Satellite downlink automation

12. Contribution over fiber and cloud

13. SDN for contribution & distribution services

14. Automating file asset workflows

User experience management (UEx)

15. Service configuration database

16. Experience & performance management 

17. Service Level Agreements

OSS / BSS workflows

18. Planned Maintenance

19. Incident management

20. Problem mgt & resolve workflows

21. Activity scheduling

22. Operational data management

23. VSAT hub and terminal provisioning

24. From warehouse to operations



1. Environmental, facilities & IoT

• drill drown from campus into buildings, 
rooms, racks, equipment

• interface with PDUs, UPS, CCTV, aircon, 
water leaking & temperature probes 
etc…

• IoT sensors & smart meter integration

• map environment to media / IT services 
for root cause analysis 

• dynamically created visual overviews

Know what’s going on in your buildings and identify impact on your media & IT services

8Al Jazeera

Visual Overview
Services

Root Cause Analysis

monitor your facility, interface with environmental 
probes, sensors and CCTV cameras & browse through 

your rooms and racks



9



2. On-premises networks & data centers
Single pane of glass to monitor, automate and keep your infrastructure secure

10

Digital twin
DataMiner IDP

Process Automation
Dashbaords

Low code apps

Any data source

Streaming telemetry

Synthetic testing

Any other system

SSO



Auto-discovery, import, export



12



security + convenience



Configuration & software mgt



15



Facility & rack mgt



17



ICT servers and OS



Compute nodes



Storage nodes



Networking



ICT servers and OS



Switches & routers



24



25



26



27



Switches & routers



29



Container environments



3. Network timing management (PTP)
Prevent operational disasters caused by PTP

31Fox, Disney, Sky, NHK, QVC, NFL, ABC,…

IDP
Dashboards

Visual Overview
Mediation

constantly monitor your entire PTP stack to 
identify,  troubleshoot and fix PTP issues easily

automated PTP infrastructure 
configuration

interface with PTP grandmasters, 
boundary clocks, transparent clocks, 
follower devices 

integrate with GNSS source, network 
infrastructure

add info from 3rd party PTP analyzers

easy-to-use operational interface



4. Managing multi-cloud workloads
Usage visualization, expense control and planning

Eliminating the need to have as many apps as you have cloud providers!

Supports the visualization of all cloud 
workloads into a single application.

Delivers instant visibility to the total cloud 
usage as well as the distribution across 
different providers and user groups

Fully flexible filtering for visualization of 
e.g.

• Hierarchy associated with a given 
instance

• Instances(resources) linked to a specific 
group or subscription (cost center)

32

Low Code Apps
Generic Query Index

Node-Edge visualization
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17. Service Level Agreements
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18. Planned Maintenance

19. Incident management

20. Problem mgt & resolve workflows

21. Activity scheduling

22. Operational data management

23. VSAT hub and terminal provisioning

24. From warehouse to operations



5. Events & jobs bookings
Manage & automate your work orders from a single platform 

34YLE

Dataminer Apps
SRM

Automation

central management of all work orders with 
single pane of glass interface, combined with 
tailored user interfaces per role / user.

• single source of truth database

• import work orders from several 
existing scheduling systems

• guided workflow from administrative 
data entry to booking execution, either 
via automation or user tasks

• keeps track of all resources

• turn work orders into bookings

• map with service definitions 

• supports ad-hoc service changes

• reserve and configure resources

• connect resources



6. Production workloads in the cloud
Orchestrate full cloud production lifecycle in an automated and efficient manner

35Customer list

Low-Code APPs
DataMiner Object Models 

(DOM)
Process Automation (PA)

Manage GVAMPP resources as well as resources outside of 
GV AMPP universe (cloud or on-prem); track resource 

utilization and costs
• application to manage lifecycle of 

productions that require cloud-based 
resources (Grass Valley AMPP)

• Plan, Deploy, Configure, Monitor, Control, 
Deconstruct

• reserve resources upfront

• Cloud, On-Prem, People, Rooms, …

• spin up and configure GV AMPP and 3rd-
party resources when needed and turn 
them down again
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IT NOC

Find any multicast by address and properties

IT network engineer

Browse physical network and drill down to flow info 

9. Flow monitoring
Context !

Table stakes

SSO

element data

IF KPI’s

IF utilization

physical network connectivity

as-is monitored flows

as-engineered flows

virtual signal groups

channel name

UMD label

production reference

booking schedule

…

Observe “as-engineered” and “as-is” flows across network and edge domains

Streaming telemetry
Flow engineering

DataMiner object models
Low-code apps

Dashboard
Data sharing

Media engineer

Browse virtual signal groups and drill down to flow info 



10. Control surfaces
Personalised, desk-aware, task-oriented, schedule aware

38

Connect vSG

Disconnect (IP …)

Grouping

Pagination

Filtering

Dynamic population 
based on GQI

Customized button 
editing

Operational status

List views

Ad-hoc controls

Penalty box

Combine with 
dashboard widgets

Dashboard sharing

SSO



12. Contribution over fiber and cloud
Multi-domain any to any connectivity made easy

39Net Insight

Dataminer Object Models 
(DOM)
SRM

LowCode Apps

end-to-end management of 
media services across managed 

networks or cloud

provision ad-hoc or scheduled 
media services

integrate with NetInsight’s
managed networks (Nimbra
Series) and cloud solution 
(Nimbra Edge)

supports 3rd-party edge devices

resource and capacity 
management

in-depth monitoring



13. SDN for contribution & distribution services
Orchestrate uncompressed & compressed media service on single converged network

40RaiWay

Dataminer SRM

DataMiner SDN controller to manage ST2022-6 / ST2110-X / ST2022-2 multicast 
streams across multiple sites  via a capacity-constraint network

multi-format, multi-service, 
multi-vendor, multi-resolution IP 
signal switching solution

advanced SDN control 
functionalities, e.g.

• lowest cost & shortest path 
calculation

• flow policy management

• diverse path routing

• NATing

SDI-like source-to-destination 
operation

service-aware monitoring



14. Automating file asset workflows
Automate repeat actions : focus on your tasks and your exceptional situations only

41Singtel

Process automation
Low code apps
Object models

Resource orchestration

Automation of your asset & file workflows

Management of storage & archive

Management of assets and files with house-specific meta data

Read asset ingest schedules from scheduler, PAM, …

Late arrival board

File ingest workflow templates tailored to the provider, 
category, …

Dynamic linking of titles to files

Fully automated processing workflows custom to the operations

Integrated with industry leading technology and SaaS providers 
including file transfer, transcode, QC, … functions

Automated resource reservation and utilization reporting 
(capacity planning)

Monitor asset and file status and position in the process

Small res preview, boxcover view, …

Individual workstations filtered on schedules and tasks
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16. Experience & performance management (EPM)
Imagine every team to find exactly what they need in a layout as works best for them

43Telenor

TV & streaming services application designed to accommodate the needs of all teams, without 
compromising the experience of any of them.

Access to all EPM 
data set

Presents exactly 
what is of the 
different team’s 
interest 

Fully customizable UI, 
allows for each 
persona or even 
workflow to have its 
own dashboard(s)  

DataMiner EPM
Low code apps



44



17. Service Level Agreements (SLA)
Enabling teams to deliver “proof of performance”

45Telenor Norway

DataMiner SLA component
Process Automation

Delivering all that relates your SLA contracts: definition, current and historical performance, 
service outage occurrence/duration

Dedicated dashboard for 
presentation of SLA 
configuration/definition (window, 
max. single/total violation time,  …)

Fully customizable visualization of 
actual service/booking SLA status 

Included an additional tab with the 
fully detailed outage list

Option to add further tabs for e.g. 
SLA history, Top-X, ….
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18. Planned Maintenance (PLM)
No unexpected outages anymore!

47Verizon, Telenor, Etisalat, …

Plan maintenance on your inventory – even cloud capacity !

Data & process-driven maintenance

Pre-defined activities for alarm masking, swap alarm 
templates, pause SLA calculation

User-defined processes to switch to redundant, 
redeploy in cloud, etc

No resource conflicts with customer service bookings

Full stack and service awareness

Convenient low-code app for dedicated planning 
and inventory management teams

Sync maintenance schedules with external and 
internal platforms (bi-directional)

Seamless integration with change management / 
ticketing systems



19. Incident management
Delivering grip, accelerating closure

48Demo

Object models
Low code apps

Process Automation
Dataminer.services

Fully featured incident management

The reference for all actively working or 
requiring visibility to incidents 

Actual implementations can vary

• simple lists with e.g. incident 
description, severity, owner and status 

• fully featured including database with 
incident types, resolution workflows and 
knowledge base items

Possibility to use process automation to  

• Initiate dashboard share (s)

• create MS Teams channel, ...
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20. Problem management
Because visibility accelerates closure  

50demo

Object models
Low code apps

As crucial as incident management in maximizing service uptime!

Facilitates the indentification 
and classification of 
problems and linked 
incidents 

Support responsibles with 
assignment, follow up and 
actual status visualization

Supports filtering across all 
data fields e.g. name, state, 
priority, assigned 
team/person, ...

ITIL defines a problem as a (poten3al) cause of one or more incidents. 
The focus for problem management is on incident preven3on.



22. Operational data management
This is what digital transformation is about : data, processes and users 

51

Digital twin & DOM
Process automation

Low-code apps
User-defined API 

People & Organization Event & job scheduling

Satellites, beams & gateways

Resources CRUD & scheduling

Contracts & rate cards

Field workforce

Field force

SSO



23. VSAT hub and terminal provisioning
All you need to manage VSAT networks in a pragmatic manner

52

All you need to deploy satellite networks, manage capacity 
and services

Satellite database

Configuration of satellite networks 
(beams & carriers)

Provisioning of VSAT hubs

Terminal inventory

Product catalog (SCPC & VSAT)

Process-driven terminal provisioning 
and activation

Management of subsriptions

Service orchestration (MHz or Mbps)

Comes with all core OSS/BSS functions : 
service mgt, change mgt, incident mgt 
etc

Integrates in existing OSS/BSS systems Low-code apps
Process automation

DataMiner IDP 
Flow management (SDN)

SRM

SSO
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